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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Standard Configuration

HP Pro 3300 MT HP Pro 3300 SFF

HP Elite 7500/7300 MT  

NOTE: The drive configuration shown above may be different than your computer model.
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Serviceability Features
The computers include features that make them easy to upgrade and service. A Torx T-15 or flat
blade screwdriver is needed for many of the installation procedures described in this guide.

Microtower Components

1 (2) external 5.25” drive bays for optional optical
drives

(1) external 3.5” drive bay for optional media
reader

6 (3) PCIe x1 slots, (1) PCIe x16 slot, (1) miniPCI
slot

2 Power Supply 7 USB Scroll Mouse

3 Rear I/O includes: (4) USB 2.0 ports, SPDIF out,
RJ-45 network interface, DVI-D and VGA video
interfaces, microphone jack, audio in/out jacks,
5.1/7.1 channel audio jacks*1

8 HP USB Standard Value Keyboard

4 Front I/O includes: (4) USB 2.0 ports, dedicated
headphone output, microphone jack

9 Monitor (sold separately)

5 (2) internal 3.5” hard drive bays   

1 HP Pro 3300 supports 5.1 channel audio, HP Pro 3305 supports 7.1 channel audio
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Small Form Factor Components

1 External 5.25” drive bay for optical drive 6 Power Supply

2 Internal 3.5” hard drive bay 7 USB Scroll Mouse

3 Rear I/O includes: (3) PCIe x1 slots, (1) PCIe x16
slot, (2) miniPCI slots USB 2.0 ports; network,
DVI-D and VGA video ports, and audio

8 HP USB Standard Value Keyboard

4 Front I/O includes: (2) USB 2.0 ports, dedicated
headphone output

9 Monitor (sold separately)

5 HP 6-in-1 Media Card Reader  HP Pro 3300 supports 5.1 channel audio, HP Pro
3305 supports 7.1 channel audio

Small Form Factor Components 3



2 Activating and Customizing the
Software

NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in Windows 7
If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Activating the Windows operating system

The first time you turn on the computer, the operating system is set up and activated automatically.
This process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.

CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the activation process may damage
the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the activation process could take up to 60 minutes.
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Downloading Windows 7 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on
the screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3. Run Windows Update monthly thereafter.

Installing or upgrading device drivers

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\i386, or use
the Browse button in the dialog box to locate the i386 folder. This action points the operating system
to the appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in Windows 8
Additional information is available in online help after you activate the operating system.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Activating the Windows Operating System

The first time you turn on the computer, the operating system is set up and activated automatically.
This process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You
can also register your computer with HP using the Register with HP app on the Start screen.

Activating and customizing the software in Windows 8 5
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CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the activation process may damage
the software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the monitor display

You can customize display settings for Windows 8 separately for the Start screen and the Desktop.

To customize the Start screen:

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings.

3. Click Personalize to change the display settings.

To customize the Desktop:

1. Click the Desktop app on the Start screen.

2. Right-click on the desktop, and then click Personalize to change display settings.
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3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

❑ always Quick Boot (default);

❑ periodically Full Boot (from every 1 to 30 days); or

❑ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

Computer Setup (F10) Utilities 7



● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at
startup, including the Computer Setup utility.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and
again repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

5. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 3-1  Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 9

Storage Computer Setup—Storage on page 10

Security Computer Setup—Security on page 13

Power Computer Setup—Power on page 17

Advanced Computer Setup—Advanced on page 18
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number

● Processor type/speed/stepping

● Cache size (L1/L2/L3) (dual core processors have this listed twice)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

● ME firmware version

● ME Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup Save to Removable Media

Saves system configuration to a formatted USB flash media device.

Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup (F10) Utilities 9



Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

● Hard Disk: Size, model, firmware version, serial number, connector color.

Translation mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to
access disks partitioned and formatted on other systems and may be necessary for users of
older versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift,
LBA Assisted, User, and Off.

Available only when the drive translation mode is set to User, allows you to specify the
parameters (logical cylinders, heads, and sectors per track) used by the BIOS to translate
disk I/O requests (from the operating system or an application) into terms the hard drive can
accept. Logical cylinders may not exceed 1024. The number of heads may not exceed 256.
The number of sectors per track may not exceed 63.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not
be changed. If the selected translation mode is not compatible with the translation mode that
was active when the disk was partitioned and formatted, the data on the disk will be
inaccessible.

● CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-
ROM).

● SSD Life Used

NOTE: Displays for solid-state drives.

● SMART (ATA disks only)

● Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

● Default Values (ATA disks only)

See Translation Mode above for details.

SATA Defaults
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Table 3-3  Computer Setup—Storage (continued)

Storage Options eSATA Port

Allows you to set a SATA port as an eSATA port for use with an external drive. Default is enabled.

This setting affects only the port with the black connector, labeled as eSATA on the system board.
This port should have the eSATA back panel connector attached to use eSATA drives. For more
information, see the eSATA white paper at www.hp.com.

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

IDE - This is the most backwards-compatible setting of the three options. Operating systems
usually do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

Max eSATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gpbs as the maximum eSATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

CAUTION: Consult your eSATA drive and cable manufacturer before enabling 3.0 Gpbs speed.
Some drive and cable combinations may not run reliably at 3.0 Gpbs.

Computer Setup (F10) Utilities 11



Table 3-3  Computer Setup—Storage (continued)

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

● EFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard
drive, USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or
included for consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

● Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded
from or included for consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

● Password prompt on F9 & F12 (requires setup password to use these boot functions).
Default is enabled.

● Network Server Mode. Default is disabled.

Smart Cover Allows you to:

● Lock/unlock the Cover Lock.

● Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if
the sensor detects that the cover has been removed.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● Embedded security device

● System audio

● USB controller (varies by model)

● Network controller

NOTE: You must disable AMT before trying to hide the network controller.

● Serial port

● Parallel port

● SATA ports (varies by model)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

● Rear USB Ports

● Accessory USB Ports

Computer Setup (F10) Utilities 13



Table 3-4  Computer Setup—Security (continued)

Slot Security Allows you to disable any PCI or PCI Express slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data
stored on the disk. Master Boot Record Security may prevent unintentional or malicious changes
to the MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities.
It also allows you to recover the "last known good" MBR, should changes to the MBR be detected
when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the
BIOS cannot prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.

Only appears if all of the following conditions are true:

● MBR security is enabled

● A backup copy of the MBR has been previously saved

● The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has
modified the MBR, may cause the data on the disk to become inaccessible. Only restore a
previously saved MBR if you are confident that the current bootable disk's MBR has been
corrupted or infected with a virus.
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Table 3-4  Computer Setup—Security (continued)

System Security
(these options are
hardware dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is
disabled.

Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and
then back on. Default is disabled.

Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset
features needed to support a virtual appliance. Changing this setting requires turning the
computer off and then back on. Default is disabled. To enable this feature you must enable the
following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device (enable/disable) - Permits activation and deactivation of the
Embedded Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all
security keys and leave the device in a disabled state. Changing this setting requires that
you restart the computer. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

● Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path
and saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker
tracks changes to any of these metrics, and forces the user to re-authenticate if it detects
any changes. Enabling this feature lets you set Bitlocker to ignore detected changes to boot
path metrics, thereby avoiding re-authentication issues associated with USB keys inserted in
a port. Default is enabled.

System Security
(continued)

OS management of Embedded Security Device (enable/disable) - This option allows the user to
limit OS control of the Embedded Security Device. Default is enabled. This option is automatically
disabled if Trusted Execution Technology is enabled.

● Reset of Embedded Security Device through OS (enable/disable) - This option allows the
user to limit the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

● No PPI provisioning (Windows 8 only) - This option lets you set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the
TPM on first boot. You cannot change this setting after TPM is owned/initialized, unless the
TPM is reset. Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

● Allow PPI policy to be changed by OS. Enabling this option allows the operating system to
execute TPM operations without Physical Presence Interface. Default is disabled.

NOTE: To enable this option, a Setup password must be set.
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Table 3-4  Computer Setup—Security (continued)

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.

Secure Boot
Configuration

This is a feature of Windows 8.

● Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set to disable, legacy boot options in Storage > Boot Order are not displayed. Default
is enabled.

● Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

● Key Management—This option lets you manage the custom key settings.

◦ Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

◦ Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that
verifies kernels during system start up, allowing you to use alternative operating
systems. Selecting HP Keys causes the computer boot using the preloaded HP-specific
boot keys. Default is HP Keys.

● Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.

From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Power

Option Description

OS Power
Management

● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern. Default is disabled.

NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4
state, not the S5 state.

◦ S0 (On) = Solid green LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCI Express x16 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets
you set lower power modes that activate when the bus is not being used. Options are Disabled,
LOs, L1, LOs and L1. Default is ASPM Disabled.

PCI Express x1 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you
set lower power modes that activate when the bus is not being used. Options are Disabled, LOs,
L1, LOs and L1. Default is ASPM Disabled.

Network Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

USB 3.0 Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-6  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot (default) = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No
more memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable). Enabling this feature will cause the system to display
POST error messages, which are error messages displayed on the monitor during the Power
On Self Test if the BIOS encounters some kind of problem while starting the PC. A POST
error message will only display on screen if the computer is capable of booting this far. If the
POST detects an error before this point, a beep code is generated instead. Default is
disabled.

● Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of
the text “Press the ESC key for Startup Menu” during POST. This text does not display on
Windows 8 systems with Fast Boot support. Other text also will not display (for example,
Ownership Tag). Default is enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is
restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST
delay also gives you more time to select F10 to enter Computer (F10) Setup. Default is
None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made. Default is disabled.
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Table 3-6  Computer Setup—Advanced (for advanced users) (continued)

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.

Bus Options Allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port,
EPP = Enhanced Parallel Port. Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

● Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA)
graphics memory allocation. The value you choose is allocated permanently to graphics and
is unavailable to the operating system. For example, if you set this value to 512M on a
system with 2 GB of RAM, the system always allocates 512 MB for graphics and the other
1.5 GB for use by the BIOS and operating system. Default is Auto which sets memory
allocation to 512 MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

● Internal Speaker (does not affect external speakers). Default is enabled.

● NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded
NIC option ROM to allow the unit to boot through the network to a PXE server. This is
typically used to download a corporate image to a hard drive. The NIC option ROM takes up
memory space below 1MB commonly referred to as DOS Compatibility Hole (DCH) space.
This space is limited. This F10 option will allow users to disable the downloading of this
embedded NIC option ROM thus giving more DCH space for additional PCI cards which may
need option ROM space. The default will be to have the NIC option-ROM-enabled. Default is
PXE.

● SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded
SATA RAID option ROM for RAID support. This can be temporarily disabled to save DCH
space. Note that with the option ROM disabled, users will be unable to boot to hard drives in
the system while running in RAID mode. Default is disabled.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

● Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

● Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.
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Table 3-6  Computer Setup—Advanced (for advanced users) (continued)

VGA Configuration Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.

AMT Configuration Allows you to set:

● AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable,
the Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

● Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This
feature should be used with caution as AMT will not be able to provide any set AMT
management functions once unconfigured. Default is disabled.

● Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to
not display the confirmation to unconfigure ME.

● Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent to the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 9 in the Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB
flash media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility. (See
Computer Setup—File on page 9 in the Computer Setup—File table.)
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4 Illustrated parts catalog

This chapter provides spare part information for all chassis.

Microtower (MT) Chassis Spare Parts

Computer Major Components
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Item Description Spare part number

(1) Access panel 657104-001

(2) Front bezel  

 For use on 3300/3305 models 657109-001

 For use on 7500/7300 models (not illustrated; bezel is identical except for branding) 657112-001

(3) Power supply, 300W 656721-001

(4) System board (includes replacement thermal material)  

 For use in models with AMD processors on 3305 models 638404-001

 For use in models with 65W Intel processors on 3300 models 656598-001

 For use in models with 95W Intel processors on 3300 models 660281-001

 For use in models with Intel processors on 7300 models 656599-001

 For use in models with Intel processors on 7500 models without Windows 8 687940-001

 For use in 7500 models with Windows 8 with no Digital Product Key (DPK) 696887-001

 For use in 7500 models with Windows 8 Standard 696887-501

 For use in 7500 models with Windows 8 Professional 696887-601

 Memory modules (not illustrated)  

 PC3-10600, 1333-MHz for use in 7300 and 3300 series models  

 ● 4-GB 585157-001

 ● 2-GB 635803-001

 ● 1-GB 635802-001

 PC3-12800, 1666-MHz for use in 7500 models  

 ● 4-GB 671613-001

 ● 2-GB 671612-001

 Processors (include replacement thermal material; not illustrated)  

 Intel processors  

 Intel Core i7:  

 ● 3770K (3.5-GHz, 8-MB L3 cache, 77W) for use only on 7500 models 688165-001

 ● 3770 (3.4-GHz, 8-MB L3 cache, 77W) for use only on 7500 models 688164-001

 ● 2600S (2.8-GHz, 8-MB L3 cache, 65W) 638419-001

 Intel Core i5:  

 ● 3570K (3.4-GHz, 6-MB L3 cache, 77W) for use only on 7500 models 688163-001

 ● 3570 (3.4-GHz, 6-MB L3 cache, 77W) for use only on 7500 models 688162-001

 ● 3550 (3.3-GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687944-001

 ● 3470 (3.2-GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687943-001

 ● 3450 (3.1-GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687942-001
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Item Description Spare part number

 ● 3330 (3.0-GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687941-001

 ● 2500S (2.7-GHz, 6-MB L3 cache, 65W) 638420-001

 ● 2500 (3.3-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models 638631-001

 ● 2405S (2.5-GHz, 6-MB L3 cache, 65W) 656790-001

 ● 2400S (2.5-GHz, 6-MB L3 cache, 65W) 640953-001

 ● 2400 (3.1-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models 638630-001

 ● 2320 (3.0 GHz, 6-MB L3 cache, 95W) for use in 3300 series models 665121-001

 ● 2310 (2.9-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models 657111-001

 ● 2300 (2.8-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models 654601-001

 Intel Core i3:  

 ● 3240 (3.4 GHz, 3-MB L3 cache, 65W) for use in 7500 series models 688951-001

 ● 3220 (3.3 GHz, 3-MB L3 cache, 65W) for use in 7500 series models 688950-001

 ● 2125 (3.3 GHz, 3-MB L3 cache, 65W) for use in 3300 series models 677427-001

 ● 2120 (3.3-GHz, 3-MB L3 cache, 65W) 638629-001

 ● 2105 (3.1-GHz, 3-MB L3 cache, 65W) 655970-001

 ● 2100 (3.1-GHz, 3-MB L3 cache, 65W) 638628-001

 Intel Pentium Dual-Core:  

 ● G870 (3.1 GHz, 3-MB L3 cache, 65W) 691936-001

 ● G860 (3.0 GHz, 3-MB L3 cache, 65W) 665122-001

 ● G850 (2.9-GHz, 3-MB L3 cache, 65W) 655973-001

 ● G840 (2.8-GHz, 3-MB L3 cache, 65W) 655972-001

 ● G640 (2.8 GHz, 3-MB L3 cache, 65W) 691935-001

 ● G630 (2.7 GHz, 3-MB L3 cache, 65W) 665123-001

 ● G620 (2.6-GHz, 3-MB L3 cache, 65W) 655971-001

 Intel Celeron:  

 ● G55 (3.3 GHz, 2-MB L3 cache, 65W) 691934-001

 AMD processors (for use in model 3305)  

 Phenom II  

 ● X6 1065T, quad core, 2-MB L2 cache, 2.9 GHz, E0 666426-001

 ● X6 1055T, quad core, 2-MB L2 cache, 2.8 GHz, C3 617838-001

 ● X6 1035T, quad core, 2-MB L2 cache, 2.6 GHz, C3 617837-001

 ● X4 z960T, dual core, 1-MB cache, 3.0 GHz, E0 632923-001

 ● X4 z840T, dual core, 1-MB cache, 2.9 GHz, E0 638410-001

 ● X2 565, dual core, 1-MB cache, 3.4 GHz, C3 657101-001
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Item Description Spare part number

 ● X2 560, dual core, 1-MB cache, 3.3 GHz, C3 657100-001

 ● X2 550, dual core, 1-MB cache, 3.1 GHz, C3 614518-001

 Athlon II X4  

 ● 650, dual core, 2-MB cache, 3.2 GHz, C3 638004-001

 ● X4 645, dual core, 2-MB cache, 3.1 GHz, C3 628883-001

 ● X4 635, dual core, 2-MB cache, 2.9 GHz, C3 617834-001

 ● X3 455, dual core, 1.5-MB cache, 3.3 GHz, C3 638003-001

 ● X3 450, dual core, 1.5-MB cache, 3.2 GHz, C3 628882-001

 ● X2 270, dual core, 1-MB cache, 3.4 GHz, C3 632922-001

 ● X2 265, dual core, 1-MB cache, 3.3 GHz, C3 632921-001

628881-001

 ● X2 260, dual core, 1-MB cache, 3.2 GHz, C3 614513-001

 ● X2 220, dual core, 1-MB cache, 2.8 GHz, C2 611192-001

 Sempron  

 ● 145, single core, 1-MB cache, 2.9 GHz, C3 638005-001
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Cables

Item Description Spare part number

(1) Power switch/LED assembly 657105-001

(2) SATA cable, 165 mm 657102-001

 Adapter, DVI to VGA, HF 657401-001

 Adapter, DVI to VGA, 29-pin, HF 657851-001

 Antenna, for use with 2x2 WLAN modules 593890-001

 Antenna, for use with 1x1 WLAN modules 701397-001
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Misc Parts

Item Description Spare part number

(1) Chassis fan 657103-001

(2) Fan sink (includes replacement thermal material)  

 For use in models with Intel processors 657402-001

 For use in models with AMD processors 656985-001

(3) Front I/O and USB assembly  

 For use on 3300/3305 models 657110-001

 For use on 7500/7300 models 657113-001

 Card reader (not illustrated)  

 15-in-1 card reader assembly 657099-001

 Card reader bezel blank 657853-001

 Card reader bezel 657854-001

 RTC battery (not illustrated) 319603-001

 Mouse (optical, USB; not illustrated) 596410-001

 RTC battery 319603-001

 Rubber feet (not illustrated) 530593-001
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Drives

Description Spare part number

Hard drive  

3-TB, 7200-rpm 696961-001

3-TB, 5400-rpm 668149-001

2-TB, 7200-rpm 616608-001

2-TB, 5400-rpm 613210-001

1.5-TB, 7200-rpm 613209-001

1.5-TB, 5400-rpm 652272-001

1-TB, 7200-rpm, 3G 621418-001

750-GB, 7200-rpm, 6G 639363-001

750-GB, 7200-rpm, 3G 632938-001

500-GB, 7200-rpm, 3G 621421-001

320-GB, 7200-rpm, 6G 636928-001

256-GB solid-state drive (SSD) 661842-001

128-GB solid-state drive (SSD) 665961-001

120-GB solid-state drive (SSD) 661841-001

Optical drive  

Blu-ray BD-RW SuperMulti DL Drive with LightScribe for use in 7500/7300 models 617030-001

16X SATA DVD±RW drive 581600-001

Bezel, optical drive 657852-001

Misc Boards

Description Spare part number

Graphics adapters for use in models without Windows 8:

ATI Radeon HD 7570 2-GB graphics adapter for use only on 7500 models 679219-001

ATI Radeon HD 7450 1-GB graphics adapter for use only on 7500 models 679218-001

ATI Radeon HD 6450 1-GB graphics adapter 638132-001

ATI Radeon HD 6570 2-GB graphics adapter, full height 638405-001

ATI Radeon HD 6570 1-GB graphics adapter 659355-001

ATI Radeon HD 6450 512-MB graphics adapter 647449-001

nVidia GeForce GT405 2-GB graphics adapter, full height 638406-001

nVidia GeForce GT405 512-MB graphics adapter 657108-001

nVidia GeForce GT520 1-GB graphics adapter, full height 657399-001
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Description Spare part number

nVidia GeForce GT530 2-GB graphics adapter, full height 657106-001

nVidia GeForce GT545 3-GB graphics adapter, full height 657107-001

nVidia GeForce GT620 1-GB graphics adapter, full height for use only on 7500 models 687579-001

nVidia GeForce GT630 2-GB graphics adapter, full height for use only on 7500 models 687580-001

nVidia GeForce GT640 3-GB graphics adapter, full height for use only on 7500 models 687226-001

Graphics adapters for use in models with Windows 8:  

ATI Radeon HD 7570 2-GB graphics adapter for use only on 7500 models with Windows 8 701403-001

ATI Radeon HD 7450 1-GB graphics adapter for use only on 7500 models with Windows 8 701402-001

nVidia GeForce GT640 3-GB graphics adapter for use only on 7500 models with Windows 8 701828-001

nVidia GeForce GT630 2-GB graphics adapter for use only on 7500 models with Windows 8 701405-001

nVidia GeForce GT620 1-GB graphics adapter for use only on 7500 models with Windows 8 701404-001

WLAN modules:

Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter for use in models with Windows 8 634906-001

Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter 701396-001

Atheros AR9462 802.11b/g/n WiFi Adapter 701398-001

Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo 701399-001

Sequential Part Number Listing

Spare part
number

Description

319603-001 RTC battery (not illustrated)

530593-001 Rubber feet

581600-001 16X SATA DVD±RW drive

585157-001 Memory module, 4-GB, PC3 10600, 1333-MH

593890-001 Antenna, for use with 2x2 WLAN modules

596410-001 Mouse, USB, optical

611192-001 AMD Athlon II X2 220 processor, dual core, 1-MB cache, 2.8 GHz, C2

613209-001 1.5-TB hard drive

613210-001 2-TB, 5400-rpm hard drive

614513-001 AMD Athlon II X2 260 processor, dual core, 1-MB cache, 3.2 GHz, C3

614518-001 AMD Phenom II X2 550 processor, dual core, 1-MB cache, 3.1 GHz, C3

616608-001 2-TB, 7200-rpm hard drive

617030-001 Blu-ray BD-RW SuperMulti DL Drive with LightScribe for use in 7300/7500 models

617834-001 AMD Athlon II X4 635 processor, dual core, 2-MB cache, 2.9 GHz, C3

28 Chapter 4   Illustrated parts catalog



Spare part
number

Description

617837-001 AMD Phenom II X6 1035T processor, quad core, 2-MB L2 cache, 2.6 GHz, C3

617838-001 AMD Phenom II X6 1055T processor, quad core, 2-MB L2 cache, 2.8 GHz, C3

621418-001 1-TB hard drive, 7200-rpm, 3G

621421-001 500-GB, 7200 RPM hard drive, 3G

628881-001 AMD Athlon II X2 265 processor, dual core, 1-MB cache, 3.3 GHz, C3

628882-001 AMD Athlon II X3 450 processor, dual core, 1.5-MB cache, 3.2 GHz, C3

628883-001 AMD Athlon II X4 645 processor, dual core, 2-MB cache, 3.1 GHz, C3

632921-001 AMD Athlon II X2 265, dual core, 1-MB cache, 3.3 GHz, C3

632922-001 AMD Athlon II X2 270 processor, dual core, 1-MB cache, 3.4 GHz, C3

632923-001 AMD Phenom II X4 z960T processor, dual core, 1-MB cache, 3.0 GHz, E0

632938-001 750-GB, 7200 RPM hard drive, 3G

634906-001 Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter for use in models with Windows 8

635802-001 Memory module, 1-GB, PC3 10600, 1333-MHz for use in only 7300 models

635803-001 Memory module, 2-GB, PC3 10600, 1333-MHz for use in only 7300 models

636928-001 320-GB, 7200 RPM hard drive, 6G

638003-001 AMD Athlon II X3 455 processor, dual core, 1.5-MB cache, 3.3 GHz, C3

638004-001 AMD Athlon II X4 650 processor, dual core, 2-MB cache, 3.2 GHz, C3

638005-001 AMD Sempron 145 processor, single core, 1-MB cache, 2.9 GHz, C3

638132-001 ATI Radeon HD 6450 1-GB graphics adapter

638404-001 System board for use in models with AMD processors on 3305 models (includes replacement thermal
material)

638405-001 ATI Radeon HD 6570 2-GB graphics adapter, full height

638406-001 nVidia GeForce GT405 2-GB graphics adapter, full height

638410-001 AMD Phenom II X4 z840T processor, dual core, 1-MB cache, 2.9 GHz, E0

638419-001 Intel Core i7 2600S processor (2.7-GHz, 8-MB L3 cache, 65W)

638420-001 Intel Core i5 2500S processor (2.7-GHz, 6-MB L3 cache, 65W)

638628-001 Intel Core i3 2100 processor (3.1-GHz, 3-MB L3 cache, 65W)

638629-001 Intel Core i3 2120 processor (3.3-GHz, 3-MB L3 cache, 65W)

638630-001 Intel Core i5 2400 processor (3.1-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models

638631-001 Intel Core i5 2500 processor (3.3-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models

640953-001 Intel Core i5 2400S processor (2.5-GHz, 6-MB L3 cache, 65W)

647449-001 ATI Radeon HD 6450 512-MB graphics adapter

652272-001 1.5-TB, 5400-rpm hard drive

654601-001 Intel Core i5 2300 processor (2.8-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models
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Spare part
number

Description

655970-001 Intel Core i3 2105 processor (3.1-GHz, 3-MB L3 cache, 65W)

655971-001 Intel Pentium Dual-Core, G620 (2.6-GHz, 3-MB L3 cache, 65W)

655972-001 Intel Pentium Dual-Core, G840 (2.8-GHz, 3-MB L3 cache, 65W)

655973-001 Intel Pentium Dual-Core, G850 (2.9-GHz, 3-MB L3 cache, 65W)

656598-001 System board for use in models with 65W Intel processors on 3300 models (includes replacement thermal
material)

656599-001 System board for use in 7300 models with Intel processors (includes thermal material)

656721-001 Power supply, 300W

656790-001 Intel Core i5 2405S (2.5-GHz, 6-MB L3 cache, 65W)

656985-001 Fan sink for use in models with AMD processors (includes replacement thermal material)

657100-001 AMD Phenom II X2 560 processor, dual core, 1-MB cache, 3.3 GHz, C3

657101-001 AMD Phenom II X2 565 processor, dual core, 1-MB cache, 3.4 GHz, C3

657102-001 SATA cable, 165 mm

657103-001 Chassis fan

657104-001 Access panel

657105-001 Power switch/LED assembly

657106-001 nVidia GeForce GT530 2-GB graphics adapter, full height

657107-001 nVidia GeForce GT545 3-GB graphics adapter, full height

657108-001 nVidia GeForce GT405 512-MB graphics adapter

657109-001 Front bezel for use on 3300/3305 models

657110-001 Front I/O and USB assembly for use on 3300/3305 models

657111-001 Intel Core i5 2310 processor (2.9-GHz, 6-MB L3 cache, 65W) for use in 7500/7300 models

657112-001 Front bezel for use on 7500/7300 models

657113-001 Front I/O and USB assembly for use on 7500/7300 models

657399-001 nVidia GeForce GT520 1-GB graphics adapter, full height

657401-001 DVI to VGA adapter, HF

657402-001 Fan sink for use in models with Intel processors (includes replacement thermal material)

657851-001 DVI to VGA adapter, 29-pin HF

657852-001 Bezel, optical drive

657853-001 Card reader bezel blank

657854-001 Card reader bezel

659355-001 ATI Radeon HD 6570 1-GB graphics adapter

660281-001 System board for use in 3300 models with 95W Intel processors

661841-001 120-GB solid-state drive
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Spare part
number

Description

661842-001 256-GB solid-state drive

665120-001 Intel Core i3 2130 processor (3.4 GHz, 3-MB L3 cache, 65W)

665121-001 Intel Core i5 2320 processor (3.0 GHz, 6-MB L3 cache, 95W)

665122-001 Intel Pentium Dual-Core G630 processor (2.7 GHz, 3-MB L3 cache, 65W)

665123-001 Intel Pentium Dual-Core G860 processor (3.0 GHz, 3-MB L3 cache, 65W)

665961-001 128-GB solid-state drive

666426-001 AMD Phenom II X6 1065T, quad core processor (2-MB L2 cache, 2.9 GHz, E0)

668149-001 3.0-TB, 5400-rpm hard drive

671612-001 Memory module, 2-GB, PC3 12800, 1666-MHz for use in only 7500 models

671613-001 Memory module, 4-GB, PC3 12800, 1666-MHz for use in only 7500 models

677427-001 Intel Core i3 2125 processor (3.3 GHz, 3-MB L3 cache, 65W)

679218-001 ATI Radeon HD 7450 1-GB graphics adapter for use only on 7500 models

679219-001 ATI Radeon HD 7570 1-GB graphics adapter for use only on 7500 models

687226-001 nVidia GeForce GT640 3-GB graphics adapter, full height for use only on 7500 models

687579-001 nVidia GeForce GT620 1-GB graphics adapter, full height for use only on 7500 models

687580-001 nVidia GeForce GT630 2-GB graphics adapter, full height for use only on 7500 models

687940-001 System board for use in 7500 models with Intel processors without Windows 8 (includes thermal material)

687941-001 Intel Core i5 3330 processor (3.0 GHz, 6-MB L3 cache, 77W) for use only on 7500 models

687942-001 Intel Core i5 3450 processor (3.1 GHz, 6-MB L3 cache, 77W) for use only on 7500 models

687943-001 Intel Core i5 3470 processor (3.1 GHz, 6-MB L3 cache, 77W) for use only on 7500 models

687944-001 Intel Core i5 3550 processor (3.2 GHz, 6-MB L3 cache, 77W) for use only on 7500 models

688162-001 Intel Core i5 3570 processor (3.3 GHz, 6-MB L3 cache, 77W) for use only on 7500 models

688163-001 Intel Core i5 3570K processor (3.3 GHz, 6-MB L3 cache, 77W) for use only on 7500 models

688164-001 Intel Core i7 3770 processor (3.4 GHz, 8-MB L3 cache, 77W) for use only on 7500 models

688165-001 Intel Core i7 3770K processor (3.5 GHz, 8-MB L3 cache, 77W) for use only on 7500 models

688950-001 Intel Core i3 3220 processor, 3.3 GHz, 3-MB L3 cache

688951-001 Intel Core i3 3240 processor, 3.4 GHz, 3-MB L3 cache

691934-001 Intel Celeron G55 processor, 3.3 GHz, 2-MB L3 cache

691935-001 Intel Pentium Dual-Core G870 processor, 3.1 GHz, 3-MB L3 cache

691936-001 Intel Pentium Dual-Core G640 processor, 2.8 GHz, 3-MB L3 cache

696887-001 System board for use in 7500 models with Windows 8 with no Digital Product Key (DPK)

696887-501 System board for use in 7500 models with Windows 8 Standard

696887-601 System board for use in 7500 models with Windows 8 Professional

696961-001 3 TB, 7200 rpm SATA hard drive
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Spare part
number

Description

701396-001 Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter

701397-001 Antenna, for use with 1x1 WLAN modules

701398-001 Atheros AR9462 802.11b/g/n WiFi Adapter

701399-001 Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo

701402-001 ATI Radeon HD 7450 1-GB graphics adapter for use only on 7500 models with Windows 8

701403-001 ATI Radeon HD 7570 2-GB graphics adapter for use only on 7500 models with Windows 8

701404-001 nVidia GeForce GT620 1-GB graphics adapter for use only on 7500 models with Windows 8

701405-001 nVidia GeForce GT630 2-GB graphics adapter for use only on 7500 models with Windows 8
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Small Form Factor (SFF) Chassis Spare Parts

Computer major components

Item Description Spare part number

(1) Access panel 656832-001

(2) Front bezel 656835-001

(3) Power supply  

 220W 656722-001

 270W 665224-001

(4) System board (includes replacement thermal material)  

 For use in models with 65W processors 656598-001

 For use in models with 95W processors 660281-001
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Item Description Spare part number

 For use in Brazil 665223-001

 Memory modules (PC3-10600, 1333-MHz; not illustrated)  

 4-GB 585157-001

 2-GB 635803-001

 1-GB 635802-001

 Processors (include replacement thermal material; not illustrated)  

 Intel Core i7 processor:  

 2600S (2.8-GHz, 8-MB L3 cache, 65W) 638419-001

 Intel Core i5 processors:  

 2500S (2.7-GHz, 6-MB L3 cache, 65W) 638420-001

 2500 (3.3 GHz, 6-MB L3 cache, 95W) 638631-001

 2405S (2.5-GHz, 6-MB L3 cache, 65W) 656790-001

 2400S (2.5-GHz, 6-MB L3 cache, 65W) 640953-001

 2400 (3.1 GHz, 6-MB L3 cache, 95W) 638630-001

 2320 (3.0 GHz, 6-MB L3 cache, 95W) 665121-001

 2310 (2.9 GHz, 6-MB L3 cache, 95W) 657111-001

 2300 (2.8 GHz, 6-MB L3 cache, 95W) 654601-001

 Intel Core i3 processors:  

 2130 (3.4 GHz, 3-MB L3 cache, 65W) 665120-001

 2120 (3.3-GHz, 3-MB L3 cache, 65W) 638629-001

 2105 (3.1-GHz, 3-MB L3 cache, 65W) 655970-001

 2100 (3.1-GHz, 3-MB L3 cache, 65W) 638628-001

 Intel Pentium Dual-Core processors:  

 G850 (2.9-GHz, 3-MB L3 cache, 65W) 655973-001

 G840 (2.8-GHz, 3-MB L3 cache, 65W) 655972-001

 G630 (2.7 GHz, 3-MB L3 cache, 65W) 665122-001

 G620 (2.6-GHz, 3-MB L3 cache, 65W) 655971-001

 G540 (2.5 GHz, 2-MB L3 cache, 65W) 665119-001

 G530 (2.4 GHz, 2-MB L3 cache, 65W) 665117-001

 G530T (2.0 GHz, 2-MB L3 cache, 35W) 665118-001
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Cables

Item Description Spare part number

(1) Power switch/LED assembly 656984-001

(2) SATA cable, 370 mm 656833-001

Misc Parts
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Item Description Spare part number

(1) Chassis fan 656834-001

(2) Fan sink (includes replacement thermal material) 657402-001

(3) Front I/O and card reader (6-in-1) 656983-001

 Fan duct (not illustrated) 657403-001

 DVI to VGA adapter (not illustrated) 202997-001

 DVI to VGA adapter, HF (not illustrated) 657401-001

 DVI to VGA adapter, HF, 29-pin (not illustrated) 657851-001

 RTC battery (not illustrated) 319603-001

 Mouse (optical, USB; not illustrated) 596410-001

 Keyboard for use in Brazil 537924-201

 Feet 660261-001

 HP business digital headset 642738-001

 Printer port kit 638817-001

 Webcam, HD-2200 671734-001

 USB webcam 609252-001

 Mouse, wireless 625685-001
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Drives

Description Spare part number

Hard drive  

2-TB, 7200-rpm 616608-001

1.5-TB, 7200-rpm 613209-001

1-TB, 7200-rpm 621418-001

750-GB, 7200-rpm 632938-001

500-GB, 7200-rpm 621421-001

320-GB, 7200-rpm 621420-001

Optical drive  

DVD-ROM drive 581599-001

16X SATA DVD±RW drive 581600-001

Misc Boards

Description Spare part number

nVidia GeForce GT530 2-GB graphics adapter 659354-001

nVidia GeForce GT520 1-GB graphics adapter 657400-001

nVidia GeForce 405 PCIe x16 graphics card, 1 GB 656789-001

ATI Radeon HD7350 512-MB graphics adapter 676356-001

ATI Radeon HD6570 1-GB graphics adapter 659355-001

ATI Radeon HD6450 PCIe x16 graphics card, 1 GB 647451-001

ATI Radeon HD6450 PCIe x16 graphics card, 512 MB 647450-001

802.11b/g/n (1x1) WLAN module 634906-001

Sequential Part Number Listing

Spare part
number

Description

202997-001 DVI to VGA adapter (not illustrated)

319603-001 RTC battery (not illustrated)

537924-201 Keyboard for use in Brazil

581599-001 DVD-ROM drive

581600-001 16X SATA DVD±RW drive

585157-001 Memory module, 4-GB, PC3 10600, 1333-MH

596410-001 Mouse, USB, optical

Small Form Factor (SFF) Chassis Spare Parts 37



Spare part
number

Description

609252-001 USB webcam

613209-001 1.5-TB hard drive

616608-001 2-TB hard drive

621418-001 1-TB hard drive

621420-001 320-GB, 7200-rpm hard drive

621421-001 500-GB, 7200-rpm hard drive

625685-001 Mouse, wireless

632938-001 750-GB, 7200-rpm hard drive

634906-001 802.11b/g/n (1x1) WLAN module

635802-001 Memory module, 1-GB, PC3 10600, 1333-MHz

635803-001 Memory module, 2-GB, PC3 10600, 1333-MHz

638419-001 Intel Core i7 2600S processor (2.7-GHz, 8-MB L3 cache, 65W)

638420-001 Intel Core i5 2500S processor (2.7-GHz, 6-MB L3 cache, 65W)

638628-001 Intel Core i3 2100 processor (3.1-GHz, 3-MB L3 cache, 65W)

638629-001 Intel Core i3 2120 processor (3.3-GHz, 3-MB L3 cache, 65W)

638630-001 Intel Core i5 2400 processor (3.1 GHz, 6-MB L3 cache, 95W)

638631-001 Intel Core i5 2500 processor (3.3 GHz, 6-MB L3 cache, 95W)

638806-001 Hood sensor

638817-001  

640953-001 Intel Core i5 2400S processor (2.5-GHz, 6-MB L3 cache, 65W)

647450-001 ATI Radeon HD6450 PCIe x16 graphics card, 512 MB

647451-001 ATI Radeon HD6450 PCIe x16 graphics card, 1 GB

654601-001 Intel Core i5 2300 processor (2.8 GHz, 6-MB L3 cache, 95W)

655971-001 Intel Pentium Dual-Core G620 processor (2.6-GHz, 3-MB L3 cache, 65W)

655972-001 Intel Pentium Dual-Core G840 processor (2.8-GHz, 3-MB L3 cache, 65W)

655973-001 Intel Pentium Dual-Core G850 processor (2.9-GHz, 3-MB L3 cache, 65W)

656598-001 System board for use in models with 65W processors (includes replacement thermal material)

656722-001 Power supply, 220W

656789-001 nVidia GeForce 405 PCIe x16 graphics card, 1 GB

656790-001 Intel Core i5 2405S processor (2.5-GHz, 6-MB L3 cache, 65W)

656833-001 SATA cable, 370 mm

656789-001 nVidia GeForce 405 PCIe x16 graphics card, 1 GB

656832-001 Access panel

656834-001 Chassis fan
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Spare part
number

Description

656835-001 Front bezel

656983-001 Front I/O and card reader (6-in-1)

656984-001 Power switch/LED assembly

657111-001 Intel Core i5 2310 processor (2.9 GHz, 6-MB L3 cache, 95W)

657400-001 nVidia GeForce GT520 1-GB graphics adapter

657401-001 DVI to VGA adapter, HF

657402-001 Fan sink (includes replacement thermal material)

657403-001 Fan duct

657851-001 DVI to VGA adapter, 29-pin HF

659354-001 nVidia GeForce GT530 2-GB graphics adapter

659355-001 ATI Radeon HD6570 1-GB graphics adapter

660261-001 Feet

660281-001 System board for use in models with 95W processors

665117-001 Intel Pentium Dual-Core G530 processor (2.4 GHz, 2-MB L3 cache, 65W)

665118-001 Intel Pentium Dual-Core G530T processor (2.0 GHz, 2-MB L3 cache, 35W)

665119-001 Intel Pentium Dual-Core G540 processor (2.5 GHz, 2-MB L3 cache, 65W)

665120-001 Intel Core i3 2130 processor (3.4 GHz, 3-MB L3 cache, 65W)

665121-001 Intel Core i5 2320 processor (3.0 GHz, 6-MB L3 cache, 95W)

665122-001 Intel Pentium Dual-Core G630 processor (2.7 GHz, 3-MB L3 cache, 65W)

665123-001 Intel Pentium Dual-Core G860 processor (3.0 GHz, 3-MB L3 cache, 65W)

665223-001 System board for use in Brazil

665224-001 Power supply, 270W

671734-001 Webcam, HD-2200

676356-001 ATI Radeon HD7350 512-MB graphics adapter

677427-001 Intel Core i3 2125 processor (3.3 GHz, 3-MB L3 cache, 65W)
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5 Serial ATA (SATA) Drive Guidelines
and Features

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 7 32 GB 2 TB

NTFS ATA Windows 7 2 TB 2 TB
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6 Routine Care, and Disassembly
Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V
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Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000
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Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes
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Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still
apply.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.
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Routine Care

General Cleaning Safety Precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 46 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 46 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 46.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 46 before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.
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● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 46.

Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 46.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

Service Considerations 47



● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 42

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.
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Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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7 Removal and Replacement Procedures
Microtower (MT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
1. Close any open software applications.

2. Exit the operating system.

3. Remove any diskette or compact disc from the computer.

4. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. In some systems the cooling fan is on
even when the computer is in the “Standby,” or “Suspend” modes. The power cord should
always be disconnected before servicing a unit.

5. Disconnect the power cord from the electrical outlet and then from the computer.

6. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Access Panel

Description Spare part number

Access panel 657104-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Using a flathead or Torx screwdriver, remove the screw on the back panel that secures the
panel to the computer.
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3. Slide the side panel toward the back, and then pull it away from the computer.

NOTE: You may want to lay the computer on its side to install internal parts. Be sure the side
with the access panel is facing up.

To replace the access panel, reverse the removal steps.

52 Chapter 7   Removal and Replacement Procedures Microtower (MT) Chassis



Front Bezel

Description Spare part number

Front bezel for use on 3300/3305 models 657109-001

Front bezel for use on 7300/7500 models 657112-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Press outward on the three latches on the right side of the bezel.

4. Remove the access panel (Access Panel on page 51).
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5. Rotate the right side of the bezel off the chassis followed by the left side.

NOTE: The appearance of the front bezel may vary.

To reinstall the front bezel, reverse the removal procedure.
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Memory
NOTE: HP Elite 7500 models use PC3-12800 memory. HP Elite 7300 and HP Pro 3300/3305
models use PC3-10800 memory.

Description Spare part number

PC3-10600, 1333-MHz for use in only 7300 and 3300 models  

4-GB 585157-001

2-GB 635803-001

1-GB 635802-001

PC3-12800, 1666-MHz for use in only 7500 models  

4-GB 671613-001

2-GB 671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DDR3-SDRAM DIMMs

The memory sockets on the system board are as follows:

– Four DIMM slots for HP Pro 3305, HP Elite 7300, and HP Elite 7500

– Two DIMM slots for HP Pro 3300

These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to:

– 16 GB for HP Pro 3305

– 8 GB for HP Pro 3300, HP Elite 7300, and HP Elite 7500

HP Pro 3300, HP Elite 7300 Memory

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-10600 DDR3-1333 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 9 DDR3 1333 MHz (9-9-9 timing)

● contain the mandatory JEDEC SPD information

Memory 55



In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

HP Elite 7500 Memory

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

Populate the DIMM sockets in the following order:

– Model 3305: DIMM1, DIMM3, DIMM2, DIMM4

– Model 3300, 7300, 7500: DIMM1, DIMM2

DIMM Socket Locations (model 3300 shown)

Table 7-1  DIMM Socket Locations

Item Description Socket Color Insertion Order

1 XMM1 socket, Channel A
(populate first)

Black 1

2 XMM2 socket, Channel A Black 2

NOTE: A DIMM must occupy the DIMM1 socket.

DIMM Socket Locations (model 7300 shown)
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Item Description Socket Color Insertion Order

1 XMM1 socket, Channel A
(populate first)

Black 1

2 XMM2 socket, Channel B Blue 3

3 XMM3 socket, Channel A Black 2

4 XMM4 socket, Channel B Blue 4

NOTE: A DIMM must occupy the XMM1 socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B.
The technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
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should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel
B should be populated with the other two 1-GB DIMMs. With this configuration, 4-GB will run as
dual channel and 1-GB will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

Removing Memory Modules

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Locate the memory module sockets on the system board.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
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4. Open both latches of the memory module socket.

5. Remove the memory module from the socket.

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the DIMM1 socket. Always populate the blue sockets before the black
sockets in each channel.

To create a dual-channel memory configuration, the memory capacity of Channel A must equal
the memory capacity of Channel B.
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To install a memory module, reverse the removal procedures.

Expansion Cards

Description Spare part number

Graphics cards for use in models without Windows 8:

ATI Radeon HD 7570 1-GB graphics adapter for use only on 7500 models 679219-001

ATI Radeon HD 7450 1-GB graphics adapter for use only on 7500 models 679218-001

ATI Radeon HD 6450 512-MB graphics adapter 647449-001

ATI Radeon HD 6450 1-GB graphics adapter 638132-001

ATI Radeon HD 6570 2-GB graphics adapter, full height 638405-001

ATI Radeon HD 6570 1-GB graphics adapter 659355-001

nVidia GeForce GT405 2-GB graphics adapter, full height 638406-001

nVidia GeForce GT405 1-GB graphics adapter, includes bracket 638407-001

nVidia GeForce GT405 512-MB graphics adapter 657108-001

nVidia GeForce GT420 2-GB graphics adapter, includes bracket 632920-001

nVidia GeForce GT440 1.5-GB graphics adapter, full height 638408-001

nVidia GeForce GT440 3-GB graphics adapter, full height 638409-001

nVidia GeForce GT520 1-GB graphics adapter, full height 657399-001

nVidia GeForce GT530 2-GB graphics adapter, full height 657106-001

nVidia GeForce GT545 3-GB graphics adapter, full height 657107-001

nVidia GeForce GT620 1-GB graphics adapter, full height for use only on 7500 models 687579-001

nVidia GeForce GT630 2-GB graphics adapter, full height for use only on 7500 models 687580-001

nVidia GeForce GT640 3-GB graphics adapter, full height for use only on 7500 models 687226-001

Graphics cards for use in models with Windows 8:

ATI Radeon HD 7570 2-GB graphics adapter for use only on 7500 models 701403-001

ATI Radeon HD 7450 1-GB graphics adapter for use only on 7500 models 701402-001

nVidia GeForce GT640 3-GB graphics adapter for use only on 7500 models 701828-001

nVidia GeForce GT630 2-GB graphics adapter for use only on 7500 models 701405-001

nVidia GeForce GT620 1-GB graphics adapter for use only on 7500 models 701404-001

The HP Pro 3300/3305 has three PCI Express x1 expansion slots, one PCI Express x16 expansion
slot, and one MiniPCI expansion slot. The expansion slots accommodate full-height or half-height
expansion cards.

Expansion Slot Locations (Model 3300 shown)
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Item Description

1 PCI Express x1 expansion slots (3)

2 PCI Express x16 expansion slot

3 MiniPCI slot

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.
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4. On the rear of the computer, a slot cover lock secures the expansion card brackets in place.
Remove the screw from the slot cover lock then slide the slot cover lock up to remove it from the
chassis.
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5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, you must remove the metal slot
cover on the rear panel that covers the expansion slot. Be sure to remove the appropriate
slot cover for the expansion card you are installing.

b. If you are removing a standard PCI card, hold the card at each end, and carefully rock it
back and forth until the connectors pull free from the socket. Pull the expansion card
straight up from the socket then away from the inside of the chassis to release it from the
chassis frame. Be sure not to scrape the card against the other components.
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c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Be sure not to scrape the card against the other
components.

6. Store the removed card in anti-static packaging.
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7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

8. To install an expansion card, locate where the card will be seated inside the computer.
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9. To install an expansion card, locate where the card will be seated inside the computer.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to Computer Setup (F10) Utility on page 7 for
instructions on using Computer Setup.
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Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cable from the P1 connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

ATX_POWER white Power supply, 24-pin

ATX_CPU white Power supply, 4-pin

SYS_FAN brown Chassis fan

CPU_FAN white Heat sink fan

INT_SPKR white Speaker

F_PANEL black Power switch

F_AUDIO yellow Front I/O audio

MINI_LED white Front_I/O

F_USB1 white Media card reader

F_USB2 white Front I/O USB

F_USB3 white Front I/O USB

SATA1 dark blue Primary hard drive

SATA2 white Primary optical drive

SATA3 light blue Second hard drive

SATA4 orange Second optical drive
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Drives

Description Spare part number

16X SATA DVD±RW drive 581600-001

Blu-ray BD-RW SuperMulti DL Drive with LightScribe for use in 7300/7500 models 617030-001

Bezel, optical drive 657852-001

3 TB, 7200 rpm SATA hard drive 696961-001

3-TB, 5400-rpm SATA hard drive 668149-001

2 TB, 7200 rpm SATA hard drive 616608-001

2-TB, 5400-rpm SATA hard drive 613210-001

1.5 TB, 7200 rpm SATA hard drive 613209-001

1.5-TB, 5400-rpm SATA hard drive 652272-001

1 TB, 7200 rpm SATA hard drive, 3G 621418-001

750 GB, 7200 rpm SATA hard drive, 3G 632938-001

500 GB, 7200 rpm SATA hard drive, 3G 621421-001

320 GB, 7200 rpm SATA hard drive, 2.5-inch, 6G 636928-001

256-GB solid-state drive 661842-001

128-GB solid-state drive 665961-001

120-GB solid-state drive 661841-001

The computer supports up to five drives that may be installed in various configurations.

This section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.
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Drive Positions

NOTE: Front bezel appearance may vary.

1 Two 5.25-inch external drive bays for optical drives

2 One 3.5-inch external drive bay for media card reader

3 Two 3.5-inch internal hard drive bays

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup. Refer to Computer Setup (F10) Utility on page 7 for more information.
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Installing Additional Drives

When installing drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect an optical drive to the light blue SATA connector on the system board labeled SATA2.

● The power cables for the SATA drives connect directly to the power supply. The primary hard
drive connects to the power connector labeled P3. the primary optical drive connects to the
power connector labeled P5.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Electrostatic Discharge Information on page 42.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

System Board Drive Connections

Refer to the following illustration and table to identify the system board drive connectors.
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System Board Connector System Board Label Color

SATA1 SATA1 dark blue

SATA2 SATA2 white

SATA3 SATA3 light blue

SATA4 SATA4 orange

Media Card Reader F_USB1 white
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Removing an Optical Drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove an optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Remove the front bezel (Front Bezel on page 53).

4. Locate the optical drives.
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5. Unlock the drive by pulling the release lever slightly away from the computer and placing in an
upright position.

6. Push the optical drive slightly forward.
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7. Disconnect the power cable and data cable from the rear of the optical drive.

8. Slide the drive out of the computer.

To install an optical drive, reverse the removal procedures.

When installing an optical drive, slide the drive back until the hole on the drive aligns with the
alignment hole on the computer.
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Removing a Hard Drive

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set to restore the operating system, software drivers,
and any software applications that were preinstalled on the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).
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3. Locate hard disk drive in the computer.

4. Remove the two screws that secure the hard drive cage to the computer.
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5. Press the latch at the side of the hard drive cage to release it.

6. Lift the cage partially out of the computer.
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7. Disconnect the cables from the of the hard drive.
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8. The cage may contain one or two hard disk drives. Each drive has two screws on each side of
the cage. Remove the screws for the drive to remove from the cage.
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9. Slide the hard drive out of the cage.

To install a hard drive, reverse the removal procedures.

When installing a hard drive, align the screw holes on the hard disk drive with the screw holes on the
cage.

When installing a hard drive cage, set the hard drive cage down into the bay, aligning the tabs on the
bottom of the cage with the tabs on the chassis.
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Front I/O and USB Panel Housing Assembly

Description Spare part number

Front I/O and USB assembly for use on 3300/3305 models 657110-001

Front I/O and USB assembly for use on 7500/7300 models 657113-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51)

3. Lay the computer on its side with the front facing toward you.

4. Remove the front bezel (Front Bezel on page 53).

5. Unplug the three cables that connect the assembly to the system board. The assembly cables
connect to the following system board connectors:

● F_AUDIO – yellow connector

● F_USB1 – white connector (blue cable)

● F_USB2 – white connector (black cable)
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6. Remove the screw (1) that secures the housing to the chassis, and then slide the housing up (2).

7. Rotate the top of the assembly outward (1), and then pull the assembly away from the chassis
(2) while guiding the cables through the hole in the chassis.

To install the housing assembly, reverse the removal procedures.

Note that the red connector and the small white connector is not used.
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Note that dual cables connect to some system board connectors as shown in the following image.
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Power Switch/LED Assembly

Description Spare part number

Power switch/LED assembly 657105-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Lay the computer on its side with the front facing toward you.

4. Remove the front bezel (Front Bezel on page 53).

5. Remove the optical drive (Removing an Optical Drive on page 74).

6. Disconnect the braided cables from the black system board connector labeled JFP1.

7. Remove the cable from the clips in the optical drive cage.
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8. Press the tab on the top of the switch holder (1) to disengage it from the chassis, lift the switch
upward to disengage the tab at the bottom of the switch (2) from the chassis, and then pull the
power switch away from the chassis while guiding the wires through the hole in the chassis.

To install the power switch/LED assembly, reverse the removal procedures.
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System Fan

Description Spare part number

Fan 657103-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Lay the computer on its side with the rear facing toward you.

4. Remove the four Phillips screws that secure the fan to the chassis, rotate the top of the fan
forward, and then remove the fan from the chassis.

NOTE: System board appearance may vary.
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5. Disconnect the cable from the red/brown system board connector labeled SYS_FAN1 (1), pull
the fan into the chassis until it clears the chassis lip, and then lift it out of the chassis (2).

To install the fan, reverse the removal procedures.
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Fan Sink Assembly

Description Spare part number

Fan sink for use in models with Intel processors 657402-001

Fan sink for use in models with AMD processors 656985-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Lay the computer on its side with the rear facing toward you.

4. Loosen the four captive Torx screws that secure the fan sink to the system board.

5. Disconnect the fan sink cable from the white system board connector labeled CPU FAN1.
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6. Lift the heat sink from the processor and set it on its side to keep from contaminating the work
area with thermal grease.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink to the processor. This is especially important as the pins on the socket
are very fragile and any damage to them may require replacing the system board.

When reinstalling an existing heat sink, make sure that its bottom has been cleaned with an alcohol
wipe and fresh thermal grease has been applied to the top of the processor. New heat sinks come
from the factory with fresh thermal grease already applied.
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Processor
Model 7500/7300/3300 uses Intel processors. Model 3305 uses AMD processors.

Description Spare part number

Intel Core i7 processors  

3770 (3.4 GHz, 8-MB L3 cache, 77W) for use only on 7500 models 688164-001

3770K (3.5 GHz, 8-MB L3 cache, 77W) for use only on 7500 models 688165-001

2600S (2.7 GHz, 8-MB L3 cache, 65W) 638419-001

Intel Core i5 processors  

3570 (3.3 GHz, 6-MB L3 cache, 77W) for use only on 7500 models 688162-001

3570K (3.3 GHz, 6-MB L3 cache, 77W) for use only on 7500 models 688163-001

3550 (3.2 GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687944-001

3470 (3.1 GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687943-001

3450 (3.1 GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687942-001

3330 (3.0 GHz, 6-MB L3 cache, 77W) for use only on 7500 models 687941-001

2500S (2.7 GHz, 6-MB L3 cache, 65W) 638420-001

2500 (3.3-GHz, 6-MB L3 cache, 65W) for use in 7300 models 638631-001

2405S (2.5-GHz, 6-MB L3 cache, 65W) 656790-001

2400S (2.5 GHz, 6-MB L3 cache, 65W) 640953-001

2400 (3.1-GHz, 6-MB L3 cache, 65W) for use in 7300 models 638630-001

2320 (3.0 GHz, 6-MB L3 cache, 95W) for use in 3300 series models 665121-001

2310 (2.9-GHz, 6-MB L3 cache, 65W) for use in 7300 models 657111-001

2300 (2.8-GHz, 6-MB L3 cache, 65W) for use in 7300 models 654601-001

Intel Core i3 processors  

3240 (3.4 GHz, 3-MB L3 cache, 65W) 688951-001

3220 (3.3 GHz, 3-MB L3 cache, 65W) 688950-001

2125 (.3 GHz, 3-MB L3 cache, 65W) 677427-001

2120 (3.3 GHz, 3-MB L3 cache, 65W) 638629-001

2105 (3.1 GHz, 3-MB L3 cache, 65W) 655970-001

2100 (3.1 GHz, 3-MB L3 cache, 65W) 638628-001

Intel Pentium Dual-Core processors  

G870 (3.1 GHz, 3-MB L3 cache, 65W) 691936-001

G860 (3.0 GHz, 3-MB L3 cache, 65W) 665123-001

G850 (2.9-GHz, 3-MB L3 cache, 65W) 655973-001

G840 (2.8-GHz, 3-MB L3 cache, 65W) 655972-001
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Description Spare part number

G860 (3.0 GHz, 3-MB L3 cache, 65W) 665122-001

G640 (2.8 GHz, 3-MB L3 cache, 65W) 691935-001

G630 (2.7 GHz, 3-MB L3 cache, 65W) 655971-001

AMD Phenom II processors:  

X6 1065T, quad core, 2-MB L2 cache, 2.9 GHz, E0 666426-001

X6 1055T, quad core, 2-MB L2 cache, 2.8 GHz, C3 617838-001

X6 1035T, quad core, 2-MB L2 cache, 2.6 GHz, C3 617837-001

X4 z960T, dual core, 1-MB cache, 3.0 GHz, E0 632923-001

X4 z840T, dual core, 1-MB cache, 2.9 GHz, E0 638410-001

X2 565, dual core, 1-MB cache, 3.4 GHz, C3 657101-001

X2 560, dual core, 1-MB cache, 3.3 GHz, C3 657100-001

X2 550, dual core, 1-MB cache, 3.1 GHz, C3 614518-001

AMD Athlon II processors:  

X4 650, dual core, 2-MB cache, 3.2 GHz, C3 638004-001

X4 645, dual core, 2-MB cache, 3.1 GHz, C3 628883-001

X4 635, dual core, 2-MB cache, 2.9 GHz, C3 617834-001

X3 455, dual core, 1.5-MB cache, 3.3 GHz, C3 638003-001

X3 450, dual core, 1.5-MB cache, 3.2 GHz, C3 628882-001

X2 270, dual core, 1-MB cache, 3.4 GHz, C3 632922-001

X2 265, dual core, 1-MB cache, 3.3 GHz, C3 632921-001

628881-001

X2 260, dual core, 1-MB cache, 3.2 GHz, C3 614513-001

X2 220, dual core, 1-MB cache, 2.8 GHz, C2 611192-001

AMD Sempron processor:  

145, single core, 1-MB cache, 2.9 GHz, C3 638005-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Lay the computer on its side with the rear facing toward you.

4. Remove the fan sink Fan Sink Assembly on page 91).
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5. If you are removing an Intel processor, rotate the locking lever to its full open position (1), raise
and rotate the microprocessor retainer to its full open position (2), and then carefully lift the
processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

CAUTION: The heat sink must be installed within 24 hours of installing the processor to
prevent damage to the processor’s solder connections.
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6. If you are removing an AMD processor, rotate the locking lever to its full open position (1), and
then carefully lift the processor from the socket (2).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

CAUTION: The heat sink must be installed within 24 hours of installing the processor to
prevent damage to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket.

2. If installing an Intel processor, close the retainer.

3. Secure the locking lever.

If reusing the existing heat sink, go to step 4.

If using a new heat sink, go to step 7.

4. If reusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided
in the spares kit.

5. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heat sink atop the processor.

6. Go to step 8.

7. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

8. Secure the fan sink to the system board and system board tray with the 4 captive screws and
attach the fan sink control cable to the system board.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.
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NOTE: After installing a new processor onto the system board, always update the system
ROM to ensure that the latest version of the BIOS is being used on the computer. The latest
system ROM BIOS can be found on the Web at: http:\\h18000.www1.hp.com/support/files.
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Power Supply

Description Spare part number

Power supply, 300W 656721-001

WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

NOTE: When installing a new power supply, be sure to set the red switch to the setting (230 V or
115 V) appropriate for the country in which the computer is used. Spare power supplies normally
arrive set for 230 V.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Lay the computer on its side with the rear facing toward you.

4. Disconnect all power cables from the mass storage devices and from the system board. The
following image points out power connectors in a system with one hard drive and one optical
drive. System configuration may vary.
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5. Remove the four screws that secure the power supply to the rear chassis.

6. Inside of the unit, press the power supply release latch on the chassis base (1).

7. Slide the power supply toward the front of the computer (2), then lift the power supply out of the
computer (3).

To install the power supply, reverse the removal procedure.
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System Board

Description Spare part number

System board for use in 3300 models with 65W Intel processors (includes thermal material) 656598-001

System board for use in 3300 models with 95W Intel processors (includes thermal material) 660281-001

System board for use in models with AMD processors on 3305 models (includes thermal material) 638404-001

System board for use in 7300 models with Intel processors (includes thermal material) 656599-001

System board for use in models with Intel processors on 7500 models without Windows 8
(includes thermal material)

687940-001

System board for use in 7500 models with Windows 8 with no Digital Product Key (DPK) (includes
thermal material)

696887-001

System board for use in 7500 models with Windows 8 Standard (includes thermal material) 696887-501

System board for use in 7500 models with Windows 8 Professional (includes thermal material) 696887-601

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules

● Processor

● Expansion cards

To remove the system board:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

3. Lay the computer on its side with the rear facing toward you.

4. Remove the front bezel (Front Bezel on page 53).

5. Remove an expansion cards (Expansion Cards on page 61).

6. Disconnect the power, and data cables from the back of all installed drives.

7. Disconnect all cables from the system board.
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8. Remove the eight screws that secure the system board to the chassis.

9. Slide the system board toward the front of the chassis, and then lift it up and out of the chassis.

To install the system board, reverse the removal procedure.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

NOTE: After installing a new system board, always update the system ROM to ensure that the
latest version of the BIOS is being used on the computer. The latest system ROM BIOS can be found
at: http:\\h18000.www1.hp.com/support/files.
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Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

❑ Do not attempt to recharge the battery.

❑ Do not expose to temperatures higher than 60°C (140°F)

❑ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

❑ Replace the battery only with the HP/Compaq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to the
Troubleshooting Without Diagnostics on page 144 chapter for information on backing up the CMOS
settings.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, its authorized partners, or its agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).
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5. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

6. Replace the computer access panel.

7. Plug in the computer and turn on power to the computer.

8. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 7.
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8 Removal and Replacement Procedures
Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
See Routine Care, and Disassembly Preparation on page 42 for initial safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Close any open software applications.

3. Exit the operating system.

4. Remove any compact disc or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Access Panel

Description Spare part number

Access panel 656832-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. If the computer is on a stand, remove the computer from the stand.

3. Remove the Torx screw that secures the access panel to the computer.
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4. Slide the access panel toward the back of the computer, and then pull it away from the
computer.

To install the access panel, reverse the removal procedure.
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Front Bezel

Description Spare part number

Front bezel 656835-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Lift up the three tabs on the top of the bezel.

4. Rotate the bezel off the chassis.

To install the front bezel, reverse the removal procedure.
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Memory

Description Spare part number

4-GB, PC3-10600 585157-001

2-GB, PC3-10600 635803-001

1-GB, PC3-10600 635802-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DDR3-SDRAM DIMMs

The memory sockets on the system board can be populated with up to two DIMMs.

These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory:

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-10600 DDR3-1333 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 9 DDR3 1333 MHz (9-9-9 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are two DIMM sockets on the system board, with one socket per channel.

Populate the DIMM sockets in the following order: DIMM1, DIMM2

NOTE: System board appearance may vary.

Item Description Socket Color Insertion Order

1 XMM1 socket, Channel A
(populate first)

Black 1

2 XMM2 socket, Channel A Black 2

NOTE: A DIMM must occupy the DIMM1 socket.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMM in Channel A is equal to the total memory capacity of the DIMM in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with one 2-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMM in Channel A is
not equal to the total memory capacity of the DIMM in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
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If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and one 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM, and Channel B should be
populated with the 1-GB DIMM. With this configuration, 2 GB will run as dual channel and 1 GB
will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

Removing DIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. For more information, refer to Electrostatic Discharge Information on page 42.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the front bezel (Front Bezel on page 107).

4. Rotate the optical drive to its upright position.
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5. Open both latches of the memory module socket (1), and remove the memory module from the
socket (2).

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

For maximum performance, populate the sockets so that the memory capacity is spread as
equally as possible between Channel A and Channel B.
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6. To install a memory module, holding the module by the edges, completely slide it into the slot.
Make sure the module is pressed completely into the socket, and then gently push down on the
module until it snaps in place.

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

For maximum performance, populate the sockets so that the memory capacity is spread as
equally as possible between Channel A and Channel B.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Card

Description Spare part number

Graphics cards  

nVidia GeForce GT530 2-GB graphics adapter 659354-001

nVidia GeForce GT520 1-GB graphics adapter 657400-001

nVidia GeForce 405 PCIe x16 graphics card, 1 GB 656789-001

ATI Radeon HD7350 512-MB graphics adapter 676356-001

ATI Radeon HD6570 1-GB graphics adapter 659355-001

ATI Radeon HD6450 PCIe x16 graphics card, 1 GB 647451-001

ATI Radeon HD6450 PCIe x16 graphics card, 512 MB 647450-001

The HP Pro 3300 SFF has one PCIe x16 expansion slot, three PCIe x1 expansion slots, and one
MiniPCI slot.

Expansion Slot Locations (Model 3300 shown)

Item Description

1 PCI Express x1 expansion slots (3)

2 PCI Express x16 expansion slot

3 MiniPCI slot
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NOTE: Board appearance and color may vary.

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

Item Description

PCIe X16 PCI Express x16 expansion slot

PCIe x1 PCIe x1 expansion slot

PCI PCI expansion slot

PCI PCI expansion slot

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.
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4. Release the slot cover bracket by removing the screw that secures the bracket, and then lifting
the bracket off the computer.

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate
expansion slot cover on the back of the chassis. Pull the slot cover straight up then away
from the inside of the chassis.
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b. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket
then away from the inside of the chassis to release it from the chassis frame. Be sure not to
scrape the card against the other components.

NOTE: PCI cards and PCI Express x1 cards do not have the retention arm. PCI Express
X16 card is shown below.

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the
expansion socket on the system board.

NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

9. Reattach the bracket to the back of the computer
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10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary.

Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cable from the P1 connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

ATX_POWER white Power supply, 24-pin

ATX_CPU white Power supply, 4-pin

SYS_FAN brown Chassis fan

CPU_FAN white Heat sink fan

INT_SPKR white Speaker

F_PANEL black Power switch

F_AUDIO yellow Front I/O audio

MINI_LED white Front_I/O

F_USB1 white Media card reader

F_USB2 white Front I/O USB

F_USB3 white Front I/O USB

SATA1 dark blue Primary hard drive

SATA2 white Primary optical drive

SATA3 light blue Second hard drive

SATA4 orange Second optical drive
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Drives

Description Spare part number

16X SATA DVD±RW drive 581600-001

DVD-ROM drive 581599-001

2 TB, 7200 rpm SATA hard drive 616608-001

1.5 TB, 7200 rpm SATA hard drive 613209-001

1 TB, 7200 rpm SATA hard drive 621418-001

750 GB, 7200 rpm SATA hard drive 632938-001

500 GB, 7200 rpm SATA hard drive 621421-001

320 GB, 7200 rpm SATA hard drive, 2.5-inch 621420-001

Drive Positions

1 5.25-inch external drive bay for an optical drive

2 3.5-inch internal drive bay for a hard drive

To verify the type and size of the storage devices installed in the computer, run Computer Setup.
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Removing Drives

When installing drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect an optical drive to the light blue SATA connector on the system board labeled SATA2.

● The power cables for the SATA drives connect directly to the power supply. The primary hard
drive connects to the power connector labeled P4. the primary optical drive connects to the
power connector labeled P3.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Electrostatic Discharge Information on page 42.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

Removing an Optical Drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the front bezel (Front Bezel on page 107).

4. Rotate the drive cage to its upright position.
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5. If removing an optical drive, disconnect the cables from the rear of the drive.

6. Remove the Torx screw from the cage.

7. Return the drive to its normal position.
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8. Push the optical drive from behind, and then remove it from the front of the computer.

Removing the Hard Drive

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the
hard drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the front bezel (Front Bezel on page 107).

4. Rotate the drive cage to its upright position.
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5. On the front of the computer, pull and hold the hard drive release latch to unlock the hard drive.

6. With the release latch pulled out, lift the rear of the hard drive.
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7. Disconnect the cables from the rear of the hard drive.

8. Remove the hard drive from the computer.
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9. Remove the four guide screws from the hard drive for use in the replacement hard drive.

To replace the hard drive, reverse the removal procedures.
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Power Switch

Description Spare part number

Power switch/LED assembly 656984-001

The power switch is attached to the front of the chassis using tabs (no screws). Its cable routes
through metal tabs in the chassis floor. The power switch cable connects to the front USB assembly
cable.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the front bezel (Front Bezel on page 107).

4. From the inside of the computer, remove the power switch cable from the tabs on the computer
floor.

Power Switch 127



5. Disconnect the power switch cable from the front USB assembly cable.

6. From the outside, front of the computer, press the tab on the right side of the power switch (1) to
disengage it from the chassis.

7. Rotate the power switch right to left (2), and then remove it from the computer (3) while routing
the cable through the hole in the front of the chassis.

To install the power switch, reverse the removal procedure.
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Front USB Assembly

Description Spare part number

Front I/O and card reader (6-in-1) 656983-001

The front USB assembly is secured to the front of the chassis with one screw. Push the assembly into
the chassis to remove it.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the front bezel (Front Bezel on page 107).

4. Disconnect the four cables from the system board as follows:

● Yellow connector labeled F_AUDIO

● White connector labeled MINI_LED

● White connector labeled F_USB3

● Black connector labeled F_USB2
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5. Remove the cables from the clip on the base pan of the computer.

6. From the front of the computer, remove the screw that secures the assembly to the front of the
chassis.
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7. Push the left side of the assembly down slightly (1), and then push the assembly into the
computer (2).

8. Remove the assembly from the computer.

To install the front USB assembly, reverse the removal procedure.
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Fan Assembly

Description Spare part number

Fan 656834-001

The fan assembly is attached to the inside floor of the chassis using two screws. The fan is inside of a
removal metal cage.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the front bezel (Front Bezel on page 107).

4. Disconnect the fan cable from the system board connector labeled SYS_FAN.

5. Remove the Torx screw that secures the left side of the fan to the computer.

6. Cut the plastic tie (1) that secures the fan cable to the power supply power cables.

7. Remove the two screws (2) that secure the fan to the computer. The screw near the computer
side is not shown in the following image.

8. Lift the fan assembly up and out of the computer (3).
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9. if you need to remove the fan from the metal case, remove the four screws that secure the fan to
the case, and remove the fan from the case.

To install the fan, reverse the removal procedure.
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Fan Sink

Description Spare part number

Fan sink 657402-001

The fan sink is secured atop the processor with four captive Torx screws. A fan cable connects to the
system board.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Loosen the four captive screws that secure the fan sink to the system board tray.

CAUTION: Fan sink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.
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4. Disconnect the cable from the system board (1), lift the fan sink from atop the processor (2) and
set it on its side to keep from contaminating the work area with thermal grease.

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink on the processor to avoid damage that could require replacing the system
board.

Failure to install the fan duct may cause the computer to overheat.
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Processor

Description Spare part number

Intel Core i7 processors  

2600S (2.7 GHz, 8-MB L3 cache, 65W) 638419-001

Intel Core i5 processors  

2500S (2.7 GHz, 6-MB L3 cache, 65W) 638420-001

2500 (3.3 GHz, 6-MB L3 cache, 95W) 638631-001

2405S (2.5-GHz, 6-MB L3 cache, 65W) 656790-001

2400S (2.5 GHz, 6-MB L3 cache, 65W) 640953-001

2400 (3.1 GHz, 6-MB L3 cache, 95W) 638630-001

2320 (3.0 GHz, 6-MB L3 cache, 95W) 665121-001-001

2310 (2.9 GHz, 6-MB L3 cache, 95W) 657111-001

2300 (2.8 GHz, 6-MB L3 cache, 95W) 654601-001

Intel Core i3 processors  

2130 (3.4 GHz, 3-MB L3 cache, 65W) 665120-001

2125 (3.3 GHz, 3-MB L3 cache, 65W) 677427-001

2120 (3.3 GHz, 3-MB L3 cache, 65W) 638629-001

2105 (3.1 GHz, 3-MB L3 cache, 65W) 655970-001

2100 (3.1 GHz, 3-MB L3 cache, 65W) 638628-001

Intel Pentium Dual-Core processors  

G860 (3.0 GHz, 3-MB L3 cache, 65W) 665123-001

G850 (2.9-GHz, 3-MB L3 cache, 65W) 655973-001

G840 (2.8-GHz, 3-MB L3 cache, 65W) 655972-001

G630 (2.7 GHz, 3-MB L3 cache, 65W) 665122-001

G620 (2.6-GHz, 3-MB L3 cache, 65W) 655971-001

G540 (2.5 GHz, 2-MB L3 cache, 65W) 665119-001

G530 (2.4 GHz, 2-MB L3 cache, 65W) 665117-001

G530T (2.0 GHz, 2-MB L3 cache, 35W) 665118-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Remove the fan sink (Fan Sink on page 134).

4. Rotate the locking lever to its full open position (1).

5. Raise and rotate the microprocessor retainer to its fully open position (2).
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6. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer. Make sure the slot in the processor fits
into the post on the socket.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.

3. If reusing the existing fan sink, clean the bottom of the fan sink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the fan sink you must clean the top of the processor and the
bottom of the fan sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the fan
sink atop the processor.

5. Go to step 7.

6. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

7. Secure the fan sink to the system board and system board tray.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the fan sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.
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NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

Description Spare part number

Power supply, 220W 656722-001

Power supply, 270W 665224-001

WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The rotating power supply is located at the rear of the chassis. It is held in place by a bracket – no
screws are used.

WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

The power supply is secured to the rear of the computer with four Torx screws. On the inside of the
computer, a tab secures the power supply to the base pan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. Rotate the drive cage up and disconnect the power cables from all of the drives.

4. Disconnect the power cables from the system board as follows:

● white 24-pin labeled P1 from ATX_POWER system board connector

● white 4-pin labeled P2 from ATX_CPU system board connector
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5. From the rear of the computer, remove the four screws that secure the power supply to the
computer.

6. On the inside of the computer, press the tab at the front of the power supply (1), pull the power
supply forward, slide it back and toward the side of the computer so it can sit lower on the
bottom of the computer, and then rotate it and lift it out of the computer (2).

To install the power supply, reverse the removal procedure.

CAUTION: When installing the power supply cables, make sure they are properly positioned so
they are not cut by the drive cage and are not pinched by the rotating power supply.
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System Board

Description Spare part number

System board for use in models with 65W processors (includes thermal material) 656598-001

System board for use in models with 95W processors (includes thermal material) 660281-001

System board for use in Brazil (includes thermal material) 665223-001

The system board is secured to the computer with six screws.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 104).

2. Remove the access panel (Access Panel on page 105).

3. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules (seeMemory on page 108)

● Expansion cards (Expansion Card on page 113)

● Heat sink (Fan Sink on page 134)

● Processor (Processor on page 136)

4. Remove the fan from the chassis (Fan Assembly on page 132).

5. Rotate the drive cage to its upright position.

6. Rotate the power supply to its full upright position.

7. Disconnect all data and power cables from the system board.

8. Disconnect the balance of the cables from the system board.
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9. Remove the six screws that secure the system board to the chassis.

10. Slide the system board away from the rear of the computer to disengage the ports, and then lift
the board up and out of the chassis.

To install the system board, reverse the removal procedure.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.
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CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not
interfere with the rotation of the drive cage or power supply.

Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

❑ Do not attempt to recharge the battery.

❑ Do not expose to temperatures higher than 60°C (140°F)

❑ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

❑ Replace the battery only with the HP/Compaq spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to the
Troubleshooting Without Diagnostics on page 144 chapter for information on backing up the CMOS
settings.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, its authorized partners, or its agents.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 50).

2. Remove the access panel (Access Panel on page 51).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).
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5. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

6. Replace the computer access panel.

7. Plug in the computer and turn on power to the computer.

8. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 7.
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A Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB
devices, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 198.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 7
for more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 198 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”
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● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 145 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/
go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

● Check that the computer is turned on and the green power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 198 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.
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● Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 169 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table A-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on
installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

To access Control Panel in Windows 7, select Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is turned on. Press the Num Lock key. The Num Lock light must be off if
you want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does
not affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover
lock . A key to unlock the Smart Cover Lock is not available
from HP. Keys are typically available from a hardware store.

Poor performance.

Cause Solution

Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.
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Table A-1  Solving General Problems (continued)

Poor performance.

Cause Solution

Virus resident on the hard drive. Run virus protection program.

Too many applications running. Windows 7:

1. Close unnecessary applications to free up memory.

2. Add more memory.

3. Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:

In Windows 7:

a. Go to Start > All Programs > Accessories > Run

b. Type msconfig, and then press Enter.

c. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

a. On the Start screen, right-click, and then select the
All apps icon.

b. Under Windows System, click Run.

c. Type msconfig, and then press Enter.

d. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

Some software applications, especially games, are stressful
on the graphics subsystem.

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open the access panel, press the power button, and
see if the processor fan (or other system fan) spins. If
the fan does not spin, make sure the fan cable is
plugged onto the system board header.

3. If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power
supply) is set to the appropriate voltage. Proper voltage
setting depends on your region.

2. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button
cable is properly connected to the system board.

3. Check that the power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table A-2  Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch
on rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open the access panel, press the power button, and
see if the processor fan (or other system fan) spins. If
the fan does not spin, make sure the fan cable is
plugged onto the system board header.

3. If fan a plugged in and not spinning, replace it.

Solving Power Problems 151



Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

2. Open the access panel and ensure the power supply
cable is seated into the connector on the system board.

3. Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If
the system enters POST, then power off and replace
one device at a time and repeat this procedure until
failure occurs. Replace the device that is causing the
failure. Continue adding devices one at a time to ensure
all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.

The incorrect external power supply adapter is being used on
the All-in One or USDT.

The power supply adapter must be at the correct power
rating and use the Smart ID technology before the system
will power up. Replace the power supply adapter with the
HP-supplied power supply adapter.
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Solving Hard Drive Problems

Table A-3  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 7, click Start, click Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and right-click
on a drive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 169 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Perform Drive Protection System (DPS) testing in
system ROM.

System files missing or not properly installed. 1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order. Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage  > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 198 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving Media Card Reader Problems

Table A-4  Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some
digital cameras use the FAT (FAT16 & FAT12) format and
can not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card
out of the slot.

In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify
the boot menu.

3. Change the boot sequence in F10 Computer Setup.
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Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table A-5  Solving Display Problems

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, select Category from the View by list,
then under Appearance and Personalization, select
Adjust screen resolution.

To access Control Panel in Windows 7, click Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2. Expand the Resolution box, and then use the sliding
control to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.
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Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.
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Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.
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“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

To enter Safe Mode in Windows 7:

1. Restart the computer.

2. Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

4. Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:

1. Press the Windows logo + l to open the Settings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, select
Startup Settings, and then click Restart.

4. Use the function keys or number keys to select the safe
mode option you want.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of
the graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad (some
models).

1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
into a document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.

In Windows 8, on the Start screen, type ch, and then select
Character Map  from the list of applications.
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Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table A-6  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged into the line-out jack and
the headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.
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Table A-6  Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause Solution

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.
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Table A-6  Solving Audio Problems (continued)

There is no sound or sound volume is too low.

Cause Solution

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table A-7  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.
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Table A-7  Solving Printer Problems (continued)

Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table A-8  Solving Keyboard Problems

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/
keyboard, or no function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard
USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.
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Table A-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press Enter.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:

1. Press the Windows logo + l to open the Settings charm.

2. Use the arrow keys to select Power, and then press
Enter.

3. Use the arrow keys to select Shut Down, and then
press Enter.

4. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table A-10  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.
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Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be
installed before DIMM2, and DIMM3 must be installed
before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be
installed before DIMM2, and DIMM3 must be installed
before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card (some models) is not seated properly or is
bad, or system board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.
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Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table A-11  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Savings.

S5 Wake on LAN is disabled (some models). Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows 7:

1. Select Start > Control Panel > Network and Sharing
Center.

2. Under Tasks, select Manage network connections.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select Allow
this device to wake the computer.

To enable Wake-on-LAN in Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications.

2. Select Network and Sharing Center, and then click the
Ethernet link next to the connection.

3. Click the Properties button.

4. Click the Configure button.

5. Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the
Start screen, type c, select Control Panel from the list
of applications, and then select Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the
Start screen, type c, select Control Panel from the list
of applications, and then select Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.
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Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network and Sharing Center icon in the Control
Panel and configure the network controller.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.

If necessary, download the softpaq from the web (from a
different computer).

Solving Network Problems 173



Table A-11  Solving Network Problems (continued)

Network controller stops working without apparent cause.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a memory
module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.
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Table A-12  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Table A-13  Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT (Trusted Execution Technology) capable
processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table A-14  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage  > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.
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Table A-14  Solving CD-ROM and DVD Problems (continued)

System will not boot from CD-ROM or DVD drive.

Cause Solution

Network Boot is enabled in Computer Setup. Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 169 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced  >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.
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Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the
Start screen, type c, select Control Panel from the list
of applications, and then select Device Manager.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.
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Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table A-15  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Flash drive is defective. Try a different flash drive.
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Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that the USB
ports are set to Enabled in Security > USB Security.

Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)
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Unable to connect to the Internet.

Cause Solution

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

Windows 7:

1. Select Start > Control Panel.

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications..

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 198 to determine possible causes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.

Cause Solution

System files may be damaged. In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system
repair disc that contains the System Recovery Options
menu. If the problem is severe enough that Startup Repair
doesn't start on its own and you can't access the System
Recovery Options menu on your computer's hard disk, you
can get to the menu and start Startup Repair by using the
Windows installation disc or a system repair disc that you
created earlier.

In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.

To access Automatic Repair:

1. Press the Windows logo + l to open the Settings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, and
then select Automatic Repair.

Windows starts Automatic Repair.

4. Select the account to use to begin Automatic Repair,
and type the password for the account.

Windows diagnoses the computer and attempts the
repair it.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support
For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.

184 Appendix A   Troubleshooting Without Diagnostics

http://www.hp.com


B HP PC Hardware Diagnostics

Use the UEFI-based hardware diagnostic solution that HP includes on all products to diagnose
hardware issues. You can use this tool even if the computer will not boot to the operating system.
This tool also works with components not diagnosed in HPSA.

Why run HP PC Hardware Diagnostics
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and
expedite the support process when issues are found. The tools save time by pinpointing the
component that needs to be replaced.

● Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

● Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.
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How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health
of the computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2. Press F2 or select Diagnostics (F2).

Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the
instructions in Downloading HP PC Hardware Diagnostics to a USB device on page 187)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible
only if the USB or hard disk drive versions are not detected
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Downloading HP PC Hardware Diagnostics to a USB
device

1. Go to http://www.hp.com.

2. Click the Support & Drivers link.

3. Select the Drivers & Software tab.

4. Enter the product name in the text box and click Search.

5. Select your specific computer model.

6. Select your operating system.

7. In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.

- or -

Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

NOTE: HP diagnostic solutions are developed to test components typically included on HP
products. They may not diagnose all third-party accessories that can be added to the system.
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C Backup and Recovery

Restoring and recovering in Windows 7
To protect from loss or damage, back up your personal data files. Refer to the operating system or
backup utility documentation for instructions on making backup copies of your data files.

To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive.

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support.
To obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.

System Restore

If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:

1. Close all open programs.

2. Click the Start button, right-click Computer, click Properties, and then click System
protection.

3. Under Protection Settings, select the disk for which you want to create a restore point.

4. Click Create, and then follow the on-screen instructions.

System Recovery

WARNING! This procedure will delete all user information. To prevent loss of information, be sure
to back up all user information so you can restore it after recovery.
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System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed
after purchase.

NOTE: Always use the System Restore procedure before you use the System Recovery program.
See System Restore on page 188.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 189 or System Recovery when Windows is not responding on page 190.

● Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 190.

System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 191.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, click Recovery Manager, and then click Recovery Manager. If prompted, click Yes
to allow the program to continue.

5. Under I need help immediately, click System Recovery.

6. Select Yes, and then click Next. Your computer restarts.

NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media that you have created. Insert the first disc or the USB flash drive, select Yes, and then
click Next to restart the computer. If you are using discs, insert the next disc when prompted.

7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files, and
you have not done so, select Back up your files first (recommended), and then click Next.
Otherwise, select Recover without backing up your files, and then click Next.
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8. System Recovery begins. After System Recovery is complete, click Finish to restart the
computer.

9. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5. Under I need help immediately, click System Recovery.

6. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing up
your files, and then click Next.

7. System Recovery begins. After System Recovery is complete, click Finish to restart the
computer.

8. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media

You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the
recovery image stored on your hard disk drive. This image contains the operating system and
software program files that were originally installed on your computer at the factory. You can create
only one set of recovery media for your computer, and the media can be used only with this
computer. Store the recovery media in a safe place.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

● To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-
R DL discs to create recovery discs.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.
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● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs
needed to make the set. If you are using a USB flash drive, the program will tell you the size of
the drive required to store all the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any
time. The next time you initiate the process, it resumes where it left off.

Creating recovery media

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, and then click HP
Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a flash drive with a capacity of at least 8 GB.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, and then click
Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much
storage is required to create the recovery drive. If the USB flash drive does not have enough
storage capacity, it will appear grayed out, and you must replace it with a larger USB flash drive.
Click Next.

NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.

Restoring and recovering in Windows 7 191



Using recovery media

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To create recovery media, see System recovery using recovery media on page 190.

To perform a System Recovery using recovery media:

1. If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2. If the computer is not responding, press and hold the power button for approximately 5 seconds
or until the computer turns off.

or

Click the Start button, and then click Shut Down.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer.

5. Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select
the boot menu and press Enter. Use the arrow keys to select the location where the recovery
media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing up
your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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Backup and recovery in Windows 8
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media, or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed
options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information. From the Start screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system
repair media and your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair media is used to start up (boot) the computer and
repair the operating system in case of system instability or failure. Your initial and subsequent
backups allow you to restore your data and settings if a failure occurs.

Type backup on the Start screen, click Settings, and then select Save backup copies of your files
with File History.

You can back up your information to an optional external hard drive, or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create
system repair media.
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Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created, you must purchase Windows 8 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 8 operating
system media (purchased separately) on page 195.

Using the Windows recovery tools

To recover information you previously backed up:

▲ From the Start screen, type h, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For
additional information go to Help and Support. From the Start screen, type h, and then select Help
and Support.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition:

From the Start screen, type e, and then click Windows Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system media and the
Driver Recovery media (both purchased separately). For additional information, see Using
Windows 8 operating system media (purchased separately) on page 195.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer after
Windows has loaded, and then press and hold Shift while clicking Restart.

NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to
the Windows Recovery Environment by default.

4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.
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Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C,
and then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media, and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system
media (purchased separately) on page 195.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the
company logo is displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order Windows 8 operating system media, go to http://www.hp.com/support, select your country or
region, and follow the on-screen instructions. You can also order the media by calling support.

CAUTION: Using Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using Windows 8 operating system media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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D Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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E POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the
memory test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 7.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table E-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card
contains an option ROM too large to
download during POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the
internal NIC from being downloaded
during POST to free more memory for
an expansion card's option ROM.
Internal PXE option ROM is used for
booting from the NIC to a PXE server.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

163-Time & Date Not Set Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly
installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card
(if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest
BIOS image.

511-CPU, CPUA, or CPUB Fan not
Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

514-CPU or Chassis Fan not Detected CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.

2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

601-Diskette Controller Error Diskette controller circuitry or floppy drive
circuitry incorrect.

1. Check and/or replace cables.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

3. Replace diskette drive.

4. Replace the system board.

605-Diskette Drive Type Error Mismatch in drive type. 1. Disconnect any other diskette
controller devices (tape drives).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

660-Display cache is detected unreliable Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict
Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict
Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 211.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer
Setup, change Storage > Storage
Options > SATA Emulation to IDE, and
select File > Save Changes and Exit.
Reenter Computer Setup and select
Security > Drivelock Security. For each
listed Drivelock-capable SATA device,
ensure Drivelock is Disabled. Lastly,
change Storage > Storage Options >
SATA Emulation back to RAID and select
File > Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the
computer, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBx execution MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2204-Inventory error during MEBx execution BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBx execution MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed. Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file
properly.

1. Try a different USB key device for
provisioning.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2217-ME Firmware Version request failure ME firmware is not properly responding to
BIOS query for version information.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2218-ME Firmware Version should be
updated

ME firmware must be updated to match
current functionality contained in the system
BIOS.

1. Update to the latest ME firmware
version.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3. If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

1. Recreate the provisioning file using
third party management console
software.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key
is not a valid version for the current ME
firmware.

1. Reboot the computer.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2230-General error during MEBx execution Error occurred during MEBx execution
which fails into the “General” grouping.
Status information displayed along with the
error provides further clarity into the failure.
MEBx handles transference of information
between the system BIOS and ME
firmware.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2231-ME error during MEBx execution Error occurred during MEBx execution
which fails into “ME” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2232-AMT error during MEBx execution Error occurred during MEBx execution
which fails into “AMT” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2233-HECI error during MEBx execution Error occurred during MEBx execution
which fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2239-ME image lock failure Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

2240-ME image unlock failure Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version and ME firmware
version.

3. If the error still persists, replace the
system board.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic
utilities.

Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table E-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes
every two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the
mouse to wake the computer.
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Table E-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heat sink/fan
assembly is not properly
attached to the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2. Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

3 Processor not installed
(not an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

4 Power failure (power
supply is overloaded).

OR

The incorrect external
power supply adapter is
being used on the USDT.

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and
repeat this procedure until failure occurs.
Replace the device that is causing the
failure. Continue adding devices one at a
time to ensure all devices are functioning
properly.

3. Replace the power supply.

4. Replace the system board.

OR

The USDT power supply adapter must be at
135W and use the Smart ID technology before
the system will power up. Replace the power
supply adapter with the HP-supplied USDT
power supply adapter.
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Table E-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace
the system board.

Red Power LED flashes
seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

7 System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest
BIOS image. See the “Boot Block
Emergency Recovery Mode” section of the
Desktop Management Guide for more
information.

2. Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

9 System powers on but is
unable to boot.

1. Check that the voltage selector, located on
the rear of the power supply (some
models), is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

3. Replace the system board.

4. Replace the processor.
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Table E-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes ten
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

10 Bad option card. 1. Check each option card by removing the
card (one at a time if multiple cards), then
power on the system to see if fault goes
away.

2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.

Red Power LED flashes
eleven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

11 The current processor
does not support a
feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10)
utility.

3. Reinstall the original processor.

System does not power on
and LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open hood and check that the power button
harness is properly connected to the
system board.

3. Check that both power supply cables are
properly connected to the system board.

4. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If
the problem persists, replace the system
board.

5. If the 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.
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F Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 7 for information on
backing up the CMOS settings.
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Resetting the Password Jumper – Models 3300/3305
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled CLR_PASS.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 2 and 3.

6. Place the jumper on pins 1 or 2.

7. Put the jumper back on pins 2 or 3.

8. Replace the access panel.

9. Reconnect the external equipment.

10. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

11. To establish new passwords, use Computer Setup.
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Resetting the Password Jumper – Model 7300/7500
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the CMOS/password header.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 5 and 3.

6. Place the jumper on pins 3 or 1 for 10-15 seconds.

7. Put the jumper back on pins 5 or 3.

8. Replace the access panel.

9. Reconnect the external equipment.

10. Plug in the computer and turn on power. Allow the operating system to start.

11. To establish new passwords, use Computer Setup.
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Clearing and Resetting the CMOS – Models 3300/3305
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P
during POST.

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled CLR_CMOS

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 2 and 3.

6. Place the jumper on pins 1 or 2.

7. Put the jumper back on pins 2 or 3.

8. Replace the access panel.

9. Reconnect the external equipment.

10. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 7.
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Clearing and Resetting the CMOS – Model 7300/7500
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P
during POST.

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the CMOS/password header.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 6 and 4.

6. Place the jumper on pins 4 or 2 for 10-15 seconds.

7. Put the jumper back on pins 6 or 4.

8. Replace the access panel.

9. Reconnect the external equipment.

10. Plug in the computer and turn on power. Allow the operating system to start.
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G Specifications

MT Specifications
Table G-1  Specifications

Chassis

Height

Width

Depth

15.08 in

6.82 in

16.58 in

38.2 cm

17.3 cm

42.1 cm

Approximate Weight 22.0 lb 10.0 kg

Temperature Range

Operating

Nonoperating

41° to 95°F

-22° to 149°F

5° to 35°C

-30° to 65°C

Relative Humidity (noncondensing)

Operating 15-90%

15-90%

15-90%

15-90%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

Power Supply

Energy Consumption

Normal Operation

Sleep (Energy Star Low Power Mode)

Off

Heat Dissipation*

Normal Operation

Sleep (Energy Star Low Power Mode)

Off

70.8 W

1.77 W

0.72 W

230 VAC

57.2 W or 195.2BTU/Hr

1.30 W or 4.44BTU/Hr

0.54 W or 1.84BTU/Hr
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Table G-1  Specifications (continued)

Model

Rated Voltage Range

300W

100-240 VAC

1 *Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

SFF Specifications
Table G-2  Specifications

Chassis

Height

Width

Depth

12.77 in

4.98 in

15.61 in

32.5 cm

10.4 cm

39.7 cm

Approximate Weight 13.9 lb 6.3 kg

Temperature Range

Operating

Nonoperating

41° to 95°F

-22° to 149°F

5° to 35°C

-30° to 65°C

Relative Humidity (noncondensing)

Operating 10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

Power Supply

Energy Consumption

Normal Operation

Sleep (Energy Star Low Power Mode)

Off

142.7 KWh

39.61 W

1.55 W

0.67 W

Model

Rated Voltage Range

220W

100-240 VAC
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Index

A
access panel

MT spare part number 51
removal and replacement 51
SFF removal and

replacement 105
SFF spare part number 105

access panel, locked 148
access panel, MT

spare part number 22, 30
access panel, SFF

spare part number 33, 38
audible codes 207
audio problems 163

B
Backup and Restore 193
battery

disposal 49
removal and replacement

102, 142
beep codes 207
booting options

Full Boot 198
Quick Boot 198

C
cable connections 69, 119
cable management 68, 118
cable pinouts

SATA data 40
cautions

AC power 42
cables 48
cooling fan 47
electrostatic discharge 42
keyboard cleaning 46
keyboard keys 47

CD-ROM or DVD problems 176

cleaning
computer 46
mouse 47
safety precautions 46

CMOS
backing up 211
clearing and resetting 214

computer cleaning 46
connecting drive cables 72
connections

system board 69, 119
country power cord set

requirements 197
Customer Support 144, 184

D
disassembly preparation 50

SFF 104
drive connectors 72
drives

connecting cables 72
installing 72
locations 71
removal and replacement 70
SFF cable connections 121
SFF installation 121
SFF locations 120

E
electrostatic discharge (ESD) 42

preventing damage 43
error

codes 198, 207
messages 199

expansion card
SFF installation 113
SFF removal 113

expansion card sockets 114

expansion slot cover
replacing 66

F
f11 recovery 195
fan

MT spare part number 89
power supply 47
removal and replacement 89
SFF spare part number 132

fan duct
spare part number 39

fan duct, SFF
spare part number 36

fan sink
MT spare part number 91
removal and replacement 91
SFF spare part number 134

fan sink, MT
spare part number 26, 30

fan sink, SFF
spare part number 36, 39

fan, MT
spare part number 26, 30

fan, SFF
spare part number 36, 38

flash drive problems 179
flashing LEDs 207
front bezel

MT spare part number 53
removal and replacement 53
SFF removal and

replacement 107
SFF spare part number 107

front bezel, MT
spare part number 22, 30

front bezel, SFF
spare part number 33, 39
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front fan
SFF removal and

replacement 132
front I/O and card reader assembly

SFF spare part number 129
spare part number 36, 39

Front I/O and USB assembly
MT spare part number 84
spare part number 26, 30

front I/O device
removal and replacement 84

front I/O, power switch assembly
SFF removal and

replacement 129
front panel problems 180

G
general problems 147
graphics card, spare part

number 37, 38, 113
grounding methods 43

H
hard drive

proper handling 48
removing 77
SATA characteristics 40
SFF installation 123
SFF removal 123
spare part number 38
spare part numbers 27, 28,

29, 37, 38
hard drive problems 153
hard drive recovery 195
hardware installation problems

169
heat sink

removal and replacement 91
SFF removal and

replacement 134
helpful hints 145
hood sensor

SFF removal and
replacement 127

spare part number 38

I
installing

drive cables 72
PCI card 66
SFF drive cables 121

SFF expansion card 113
SFF hard drive 123
SFF memory 108

Internet access problems 180

K
keyboard

cleaning 46
keyboard problems 167

L
LEDs

blinking power 207
blinking PS/2 keyboard 207

M
Media Card Reader problems

156
memory

populating sockets 57, 109
removal and replacement 55
SFF installation 108
specifications 55, 108

memory module
spare part number 55, 108

memory modules
spare part number 22, 28, 29,

31, 34, 37, 38
memory problems 174
microtower components 2
monitor problems 158
mouse

cleaning 47
spare part number 26, 36

mouse problems 167
MT

access panel, spare part
number 22, 30

fan sink, spare part number
26, 30

fan, spare part number 26, 30
front bezel, spare part

number 22, 30
power supply, spare part

number 22, 30
power switch/LED assembly,

spare part number 30
SATA cable, spare part

number 25
system board, spare part

number 22, 29, 30

N
network problems 171
numeric error codes 199

O
operating guidelines 45
optical drive

removing 74
SFF removal 121
spare part numbers 27, 28,

37
optical drive problems 176
overheating, prevention 45

P
password

clearing 211
power-on 211
setup 211

PCI card 64, 65, 66, 114
PCI Express card 65, 114
POST error messages 198
power cord set requirements

country specific 197
power problems 151
power supply

fan 47
operating voltage range 216,

217
removal and replacement 98
SFF removal and

replacement 138
power supply, MT

spare part number 22, 30
power supply, SFF

spare part number 33, 38
power switch/LED

removal and replacement 87
power switch/LED assembly

MT spare part number 87
SFF spare part number 127

power switch/LED assembly, MT
spare part number 25, 30

power switch/LED assembly, SFF
spare part number 35, 39

power-on password 211
preparation for disassembly 50
printer problems 165
problems

audio 163
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CD-ROM or DVD 176
flash drive 179
front panel 180
general 147
hard drive 153
hardware installation 169
Internet access 180
keyboard 167
Media Card Reader 156
memory 174
monitor 158
mouse 167
network 171
power 151
printer 165
processor 176
software 182

processor
removal and replacement 94
SFF removal and

replacement 136
spare part number 22, 29, 34,

38
processor problems 176

R
recovery partition 195
removal and replacement

access panel 51
battery 102, 142
drives 70
fan 89
fan sink 91
front bezel 53
front I/O device 84
heat sink 91
memory 55
power supply 98
power switch 87
processor 94
SFF front bezel 105, 107
SFF front fan 132
SFF front I/O, power switch

assembly 129
SFF heat sink 134
SFF hood sensor 127
SFF power supply 138
SFF processor 136
SFF system board 140
system board 100

removing
hard drive 77
optical drive 74
PCI card 64, 65
PCI Express card 65
SFF expansion card 113
SFF hard drive 123
SFF optical drive 121

resetting
CMOS 211
password jumper 211

restoring the hard drive 195

S
safety and comfort 144
safety precautions

cleaning 46
SATA

connectors on system board
40

data cable pinouts 40
hard drive characteristics 40

SATA cable, MT
spare part number 25

SATA cable, SFF
spare part number 35

screws, correct size 48
SDRAM (synchronous dynamic

random access memory 55
service considerations 47
serviceability features 2
setup password 211
SFF

access panel, spare part
number 33, 38

disassembly preparation 104
fan duct, spare part number

36
fan sink, spare part number

36, 39
fan, spare part number 36, 38
front bezel removal and

replacement 105, 107
front bezel, spare part

number 33, 39
front fan removal and

replacement 132
front I/O, power switch

assembly removal and
replacement 129

heat sink removal and
replacement 134

hood sensor removal and
replacement 127

power supply removal and
replacement 138

power supply, spare part
number 33, 38

power switch/LED assembly,
spare part number 25, 35,
39

preparation for disassembly
104

processor removal and
replacement 136

SATA cable, spare part
number 35

system board removal and
replacement 140

system board, spare part
number 33, 38

small form factor components 3
software

problems 182
servicing computer 47

spare part number
tamper-resistent wrench 48
Torx T-15 screwdriver 47

specifications
computer 216
memory 55, 108

static electricity 42
system board

MT spare part number 100
removal and replacement 100
SATA connectors 40
SFF removal and

replacement 140
SFF spare part number 140

system board drive connections
72

system board, MT
spare part number 22, 29, 30

system board, SFF
spare part number 33, 38

T
tamper-proof screws

tool 48
temperature control 45
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tools, servicing 47
Torx T15 screwdriver 47

V
ventilation, proper 45

W
Wake-on-LAN feature 171
Windows 8 operating system

DVD 195
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